
 

GABAY SA GUMAGAMIT NG 

Nokia PC Suite 6.85 
 

 



Mga Nilalaman 

1. Panimula ............................................................................................................................1 
1.1 Mga aplikasyon ng Nokia PC Suite ..............................................................................................1 
1.2 Mga dapat na mayroon.................................................................................................................2 
1.3 Karagdagang impormasyon .........................................................................................................4 

2. Pag-install ng Nokia PC Suite ..........................................................................................6 
2.1 Bago ang instalasyon ...................................................................................................................6 
2.2 Pag-install ng Nokia PC Suite mula sa CD-ROM.........................................................................6 
2.3 Pag-install ng Nokia PC Suite mula sa Web ................................................................................7 
2.4 Pag-uninstall ng Nokia PC Suite ..................................................................................................7 
2.5 Pagpapalit ng wikang ginagamit sa Nokia PC Suite ....................................................................8 

3. Pag-install sa mga driver..................................................................................................9 

4. Pagkonekta sa iyong telepono at PC ............................................................................10 
4.1 Pagpili sa uri ng koneksyon........................................................................................................10 
4.2 Pagkonekta ng iyong telepono sa cable.....................................................................................11 
4.3 Pagkonekta ng iyong telepono sa infrared .................................................................................11 
4.4 Pagkonekta ng iyong telepono sa Bluetooth ..............................................................................11 

4.4.1 Pagpapares ng mga aparato para sa Bluetooth na koneksyon .........................................12 
4.5 Mga konektadong telepono ........................................................................................................12 

5. Paggamit ng Nokia PC Suite ..........................................................................................14 
5.1 Pangunahing window ng Nokia PC Suite ...................................................................................15 
5.2 Pag-back up sa mga nilalaman ng telepono a isang PC............................................................16 
5.3 Pag-synchronise ng data sa pagitan ng iyong telepono at PC...................................................17 
5.4 Pagkonekta sa Internet gamit ang iyong telepono .....................................................................19 
5.5 Pag-install ng mga aplikasyon sa iyong telepono mula sa PC...................................................20 
5.6 Pamamahala sa mga nilalaman ng telepono sa PC ..................................................................21 
5.7 Pagdaragdag ng mga contact sa iyong telepono mula sa PC ...................................................22 
5.8 Pagpapadala ng mga tekstong mensahe mula sa PC ...............................................................22 
5.9 Pagtingin ng mga file na multimedia sa PC................................................................................23 
5.10 Pagtatabi ng mga imahe mula sa iyong telepono papunta sa PC ...........................................23 
5.11 Paglilipat ng musika mula sa CD papunta sa iyong telepono ..................................................24 

6. Mga katawagan at mga daglat .......................................................................................26 

7. Mga talang pangkaligtasan ............................................................................................27 

INDEX ....................................................................................................................................28 

 

 



1. PANIMULA 

Ang gabay na ito ay nagbibigay sa iyo ng mga tagubilin kung paano i-install ang Nokia PC 
Suite, ikonekta ang iyong telepono sa PC, at simulang gamitin ang mga aplikasyon ng Nokia 
PC Suite. 

1.1 Mga aplikasyon ng Nokia PC Suite 

Sa Nokia PC Suite maaari mong i-edit, itabi, at i-synchronise ang data ng iyong Nokia mobile 
phone sa isang PC system na gumagamit ng Microsoft Windows. Ang Nokia PC Suite ay 
binubuo ng mga sumusunod na aplikasyon: 

Sa Nokia PC Suite maaari kang Sa anong aplikasyon Icon 
Mag-back up ng personal na data mula sa iyong telepono 
papunta sa PC. 

Ibalik ang personal na data mula sa iyong PC papunta sa 
anumang suportadong telepono. 

I-backup  

(Nokia Content Copier) 

 

 

Mag-synchronise ng personal na data sa pagitan ng 
telepono at PC. 

I-synchronise  

(Nokia PC Sync)  

Gumamit ng iyong telepono bilang modem para ikonekta 
ang iyong PC sa Internet. 

Kumonekta sa Internet 

(One Touch Access)  

Maglipat ng mga file sa pagitan ng telepono at PC. 

Tingnan ang mga file at mga folder ng iyong telepono sa 
PC. 

Manager ng file 

(Nokia Phone Browser)  

Gumawa, tumingin, magtanggal, o mag-edit ng mga 
contact sa PC. 

Mga contact  

(View ng Mga contact sa 
Nokia Phone Browser) 

 

Magpadala ng mga tekstong mensahe mula sa iyong PC. 

Tumingin, magtanggal, at magsaayos ng mga natanggap 
na tekstong mensahe sa PC. 

Mga Mensahe  

(View ng Mga mensahe sa 
Nokia Phone Browser) 

 

Mag-rip ng mga CD, gumawa at magsaayos ng mga track 
ng musika sa PC at ilipat ang mga ito sa iyong telepono. 

Mag-convert ng mga file na musika sa pormat na maipi-
play sa iyong telepono. 

Maglipat ng musika 

(Nokia Music Manager) 

 

 

Magtabi ng mga imahe at mga video clip mula sa iyong 
telepono sa PC. 

Magtabi ng mga imahe 

(Image Store)  
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Sa Nokia PC Suite maaari kang Sa anong aplikasyon Icon 
Magbukas ng mga imahe, mga video clip, mga 
mensaheng multimedia, at mga file na audio. 

Gumawa ng mga playlist ng iyong mga paboritong file na 
multimedia. 

Mag-save ng mga file na video at audio sa pormat na 
pareho mong magagamit sa iyong telepono at sa mga 
mensaheng MMS. 

Tingnan ang multimedia 

(Nokia Multimedia Player) 

 

 

 

Mag-install ng mga laro at mga programa mula sa PC 
papunta sa iyong telepono. 

Mag-install ng mga 
aplikasyon  

(Nokia Application Installer) 
 

Tingnan ang Internet para sa mga update ng software ng 
telepono, at i-update ang iyong software ng telepono para 
sa karagdagang function at mas pinabuting performance. 

I-update ang software ng 
telepono 

(Nokia Software Updater) 
 

 

Para sa impormasyon sa mga gawain na maaari mong isagawa sa mga aplikasyon ng Nokia 
PC Suite, tingnan ang mga tulong sa aplikasyon, at seksyon 5, Paggamit ng Nokia PC Suite 
sa gabay na ito. 

 
Paalala: Ang Nokia Multimedia Player, Image Store, at Nokia Music Manager ay di 
kasama sa Nokia PC Suite Starter Edition.  

1.2 Mga dapat na mayroon 

Para gawin ito Kailangan mayroon kang 
Para i-install at paganahin 
ang Nokia PC Suite 

• Kahit 200 MB na bakanteng lugar sa disk 

• Isa sa mga sumusunod na operating system: 

• Windows Vista x32 at x64 editions  

• Windows XP Professional x64 edition  

• Windows XP (Professional, Home Edition, Media 
Center Edition o Tablet PC Edition) ( Service Pack 2)  

• Windows 2000 (Service Pack 4)  

• Mga karapatan ng administrator sa PC para makapag-
install ng software doon 

Para ikonekta ang iyong 
telepono sa isang PC 

Kahit na isa sa mga sumusunod na set ng koneksyon 

• USB cable na pangkonekta (DKU-2, DKE-2, CA-53, CA-
70 o CA-101) at isang tugmang port sa iyong PC 

• Serial cable na pangkonekta CA-42 at isang tugmang port 
sa iyong PC  

• Infrared (IrDA) port sa iyong PC  

• Bluetooth wireless technology na kagamitan at software 
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Para gawin ito Kailangan mayroon kang 
Para gumawa ng Bluetooth 
wireless technology na 
koneksyon sa pagitan ng 
iyong telepono at PC 

Bluetooth wireless technology na kagamitan na na tugma sa isa sa 
mga suportadong Bluetooth stack na nakalista sa ibaba:: 

Windows Vista x32 at x64 edition: 

• Microsoft Windows Bluetooth stack  

• Toshiba Bluetooth stack, bersiyon ng driver 5.10.12 

• IVT BlueSoleil Bluetooth stack, bersiyon ng driver 5.0.5 

Windows XP x64: 

• Microsoft Windows Bluetooth stack  

• Toshiba Bluetooth stack, bersiyon ng driver 5.10.12 

• IVT BlueSoleil Bluetooth stack, bersiyon ng driver 5.0.5 

Windows XP: 

• Microsoft Windows Bluetooth (sa Service Pack 2 lamang)  

• Toshiba Bluetooth stack, bersiyon ng driver 4.0, 5.0 at 
5.10.12 

• WIDCOMM Bluetooth stack, bersiyon ng driver 1.4.2, 3.x, 
4.x at 5.x  

• IVT BlueSoleil Bluetooth stack, bersiyon ng driver 2.x, 3.x 
at 5.0.5  

Windows 2000: 

• Toshiba Bluetooth stack, bersiyon ng driver 4.0, 5.0 at 
5.10.12 

• WIDCOMM Bluetooth stack, bersiyon ng driver 1.4.2, 3.x, 
4.x at 5.x  

• IVT BlueSoleil Bluetooth stack, bersiyon ng driver 2.x, 3.x 
at 5.0.5 

Paalala: Ang mga magagamit na Bluetooth na teknolohiya at ang 
kanilang mga bersyon ay maaaring di suportado ng iyong Nokia 
mobile na aparato. Tingnan ang iyong gabay sa gumagamit ng 
Nokia mobile na aparato para sa karagdagang detalye tungkol sa 
pagiging tugma sa mga nakalistang Bluetooth na teknolohiya. 

Paalala: Para tingnan kung anong Bluetooth stack ang naka-install 
sa iyong PC: sa pangunahing window ng Nokia PC Suite, i-click 
ang Tulong > Tungkol sa Nokia PC Suite > Info ng sistema… 
Kung ang Bluetooth stack na nakita sa iyong PC ay di suportado ng 
Nokia PC Suite, ito ay nabanggit din sa info ng sistema. 
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Para gawin ito Kailangan mayroon kang 
Para gawin ang mga gawain 
sa mga aplikasyon ng Nokia 
PC Suite 

Isang tugmang telepono. Ang ilang katangian ay maaari lang 
gamitin sa mga modelo ng telepono na sumusuporta sa mga 
katangiang iyon. Halimbawa, di lahat ng modelo ng telepono ay 
sumusuporta sa pagpapadala ng mga mensaheng multimedia. 

Para tingnan kung anong mga bersyon ng Nokia PC Suite, mga 
aplikasyon ng Nokia PC Suite, at mga uri ng koneksyon ang 
sinusuportahan ng iyong modelo ng telepono, tingnan ang 
www.nokia.com/pcsuite/compatibility. 

 

 
Paalala: Dapat mong gamitin ang parehong wika sa telepono, sa operating system, at 
Nokia PC Suite, kung maaari. Binibigyang-kakayahan nito ang iyong telepono na 
gumana ng maayos sa lahat ng aplikasyon ng Nokia PC Suite.  

 
Paalala: Laging tiyakin na ikaw ay gumagamit ng mga orihinal na Nokia cable sa Nokia 
PC Suite upang matiyak ang secure na operasyon ng mga aplikasyon ng PC Suite. 
Tiyakin ang tatak sa iyong cable. 

 
Paalala: Lahat ng patungkol sa isang PC sa gabay na ito ay pantay na ginagamit sa 
isang laptop na computer. 

1.3 Karagdagang impormasyon 

Para sa karagdagang impormasyon tungkol sa Nokia PC Suite, tingnan ang mga sumusunod 
na sanggunian: 

• Nokia PC Suite tulong, na naglalaman ng mga detalyadong tagubilin sa paggamit ng 
Nokia PC Suite. Para buksan, i-click ang Tulong > Mga tulong na paksa, i-click ang 
pindutan ng Tulong sa window, o pindutin ang F1 sa mga aplikasyon ng Nokia PC 
Suite. 

• Tutorial para sa PC Suite na naglalaman ng mga step-by-step na demo ng mga 
aplikasyon ng Nokia PC Suite. Para buksan, i-click ang Web > Nokia PC Suite 
tutorial sa pangunahing window ng Nokia PC Suite. Para magamit ang tutorial 
kailangan mayroon kang koneksyon sa Internet. 

• Nokia PC Suite FAQ Search na naglalaman ng impormasyon sa pag-troubleshoot sa 
Nokia PC Suite. Para i-access ang impormasyon, i-click ang Web > Nokia PC Suite 
sa web > PC Suite FAQ sa pangunahing window ng Nokia PC Suite. Para i-browse 
ang database ng paghanap sa FAQ kailangan mayroon kang koneksyon sa Internet. 

Para sa impormasyon kung paano gamitin ang iyong Nokia mobile phone, tingnan ang 
gabay sa gumagamit ng telepono. 

 
Tip: Maaari kang magrehistro para sa libreng buwanang Nokia Connections newsletter 
para makakuha ng kapaki-pakinabang na impormasyon at mga espesyal na alok sa mga 
pinakahuling Nokia device, accessory at software (halimbawa, mga bagong bersiyon ng 
PC Suite). Ang Nokia Connections ay nakahanda sa ilang wika at maaaring maihatid ito 
sa iyong e-mail o teleponong mobile. Para mag-subscribe sa Nokia Connections sa 
Internet, piliin ang Web > Sign Up sa pangunahing window ng Nokia PC Suite. 
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Paalala: Basahing mabuti ang mga teksto ng Paalala na minarkahan gaya nito, dahil 
madalas na nagtataglay ng impormasyon ang mga ito na maaaring makatulong sa iyo 
para makaiwas sa mga posibleng problema. 
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2. PAG-INSTALL NG NOKIA PC SUITE  

Maaari mong i-install ang Nokia PC Suite mula sa CD-ROM, o mula sa pahina sa Web ng 
Nokia PC Suite sa www.nokia.com/pcsuite. Kailangan mo ng mga karapatan ng 
administrator sa iyong PC para ma-install ang software dito. 

Para makapagtatag ng koneksiyon sa pagitan ng iyong telepono at ng PC kailangan 
mayroon kang mga naka-install na driver sa iyong PC. Ang mga driver ay awtomatikong ini-
install kapag nag-install ka ng Nokia PC Suite at ikinonekta ang iyong telepono sa PC gamit 
ang Maging Konektado wizard. Para sa detalyadong impormasyon tingnan ang seksyon 3, 
Pag-install sa mga driver sa gabay na ito. 

 
Tip: Kung ikaw ay may naka-install na Nokia PC Suite at ikaw ay konektado sa Internet, 
ang Nokia PC Suite ay magpapakita ng isang abiso kapag may bagong labas na Nokia 
PC Suite, o patch para sa pinakabagong release, na nakahanda para mai-download. 

2.1 Bago ang instalasyon 

Kung ikaw ay may lumang bersyon ng Nokia PC Suite (5.x o 6.x) na naka-install sa iyong PC, 
ang lumang bersyon ay awtomatikong papalitan sa oras ng instalasyon. Kung sa ilang 
kadahilanan ay kailangan mong manwal na i-uninstall ang lumang bersyon, hihingin sa iyo 
ng programa ng instalasyon na gawin ito. 

Kung nais mong gumamit ng Bluetooth na koneksyon, i-install ang software ng Bluetooth 
wireless technology sa iyong PC bago mo i-install ang Nokia PC Suite. Para sa karagdagang 
impormasyon sa software ng Bluetooth na magagamit mo sa Nokia PC Suite, tingnan ang 
seksyon 1.2, Mga dapat na mayroon sa gabay na ito. 

Kung ikaw ay naga-upgrade mula sa Nokia PC Suite 6.41 o mas luma papunta sa Nokia PC 
Suite 6.85, i-synchronise ang iyong telepono sa kasalukuyang Nokia PC Suite bago mag-
upgrade, para maiwasan ang mga duplikadong tipanan sa kalendaryo. Kapag iyong na-install 
ang Nokia PC Suite 6.85, gawin uli ang pag-synchronise. 

2.2 Pag-install ng Nokia PC Suite mula sa CD-ROM 

Maaari mong i-install ang Nokia PC Suite mula sa CD-ROM kung ang ibinentang pakete ng 
iyong telepono ay nagtataglay nito. 

1. Para simulan ang instalasyon, ipasok ang CD-ROM sa CD-ROM drive ng iyong PC at 
i-click ang opsyon ng instalasyon. 

2. Piliin ang wika, at i-click ang OK. Ang programa ng instalasyon ay magsisimula. 

3. Sundin ang mga tagubilin sa screen, at tandaan ang mga sumusunod: 
• Kung konektado ka sa Internet, aalamin ng Nokia PC Suite kung may na-update 

na bersyon ng Nokia PC Suite na nakahanda sa Pahina sa web ng Nokia PC 
Suite. Kung oo, inirerekomenda na iyong i-download at i-install ang bagong 
bersyon. 

• Dapat mong basahin at tanggapin ang Kasunduan sa lisensiya bago magpatuloy. 
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• Maaaring hingin sa iyo na muling simulan ang computer sa oras ng instalasyon. 
4. Kapag nakumpleto ang instalasyon, ang Maging Konektado wizard ay awtomatikong 

bubukas at maaari mong piliin ang mga uri ng koneksyon na nais mong gamitin. 

5. Depende sa modelo ng iyong telepono, maaaring kailanganin mong i-install ang 
suportang aplikasyon ng PC Suite para sa SMS at MMS na pagmemensahe. 
Ipapaalam sa iyo ng Maging Konektado wizard ang instalasyon. Tandaan na dapat 
mong kumpletuhin ang instalasyon sa user interface ng iyong telepono. 

2.3 Pag-install ng Nokia PC Suite mula sa Web 

1. Magbukas ng Web browser at pumunta sa www.nokia.com/pcsuite > Download. 
Ang download assistant ay bubukas. 

2. Piliin kung kailangan mo ng tulong para malaman kung anong bersyon ng PC Suite 
ang angkop para sa iyong modelo ng telepono, o kung gusto mong i-download ang 
pinakahuling bersyon ng PC Suite. 

3. Kung pinili mong gumamit ng tulong, susunod na piliin ang modelo ng iyong telepono 
at i-click ang Continue. Kung may dalawang bersyon na magagamit sa iyong 
telepono, hihingin sa iyong piliin ang operating system ng iyong PC. 

4. Piliin ang wika na ida-download mula sa drop-down na lista at i-click ang Download.  

5. I-click ang Run o Open para simulan ang instalasyon.  
O 
I-click ang Save at i-save ang file sa iyong PC. Tapos ay mag-browse sa na-download 
na file na Nokia_PC_Suite_685_rel_xx_xx_web.msi at i-click ito para simulan ang 
pag-install. 

6. Sundin ang mga tagubilin sa pag-install sa screen, at tandaan ang mga sumusunod: 
• Dapat mong basahin at tanggapin ang Kasunduan sa lisensiya bago magpatuloy. 
• Maaaring hingin sa iyo na muling simulan ang computer sa oras ng instalasyon. 

7. Kapag nakumpleto ang instalasyon, ang Maging Konektado wizard ay awtomatikong 
bubukas at maaari mong piliin ang mga uri ng koneksyon na nais mong gamitin. 

8. Depende sa modelo ng iyong telepono, maaaring kailanganin mong i-install ang 
suportang aplikasyon ng PC Suite para sa SMS at MMS na pagmemensahe. 
Ipapaalam sa iyo ng Maging Konektado wizard ang instalasyon. Tandaan na dapat 
mong kumpletuhin ang instalasyon sa user interface ng iyong telepono. 

2.4 Pag-uninstall ng Nokia PC Suite 

1. I-click ang Start > Programs > Nokia PC Suite > Uninstall Nokia PC Suite. 

2. Sundin ang mga tagubilin sa screen hanggang ang mga file ng programa ay maalis. 

O 

1. I-click ang Start > Settings > Control Panel. 
(Kung ikaw ay gumagamit ng Windows XP, gamitin ang Classic View ng Control 
Panel.) 
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2. Idobleng-click ang Add/Remove Programs. 

3. Mula sa listahan ng Currently Installed Programs, i-click ang Nokia PC Suite. 

4. I-click ang Change/Remove. Kung ikaw ay nag-click sa Change, kailangan mong 
i-click ang Remove sa window na bubukas. 

5. Sundin ang mga tagubilin sa screen hanggang ang mga file ng programa ay maalis. 

 
Paalala: Kapag nag-uninstall ka ng Nokia PC Suite, ang mga driver na na-install kasama 
ng Nokia PC Suite ay maa-uninstall din. Kung hiwalay kang nag-update ng mga Nokia 
Connectivity Cable Driver matapos mag-install ng Nokia PC Suite ang mga driver ay 
hindi maa-uninstall. 

2.5 Pagpapalit ng wikang ginagamit sa Nokia PC Suite 

Kung ikaw ay may naka-install na Nokia PC Suite at nais mong palitan ang wika na 
ginagamit sa mga aplikasyon ng Nokia PC Suite, gawin ang isa sa mga sumusunod: 

• Para i-install ang parehong bersyon ng Nokia PC Suite sa ibang wika: i-uninstall ang 
Nokia PC Suite at piliin na muling i-install ito sa bagong wika mula sa CD-ROM o mula 
sa mga pahina sa Web ng Nokia PC Suite. 

• Para i-install ang mas bagong bersyon ng Nokia PC Suite sa ibang wika: piliing i-install 
ang Nokia PC Suite sa bagong wika. Ang lumang bersyon ng Nokia PC Suite at mga 
wika nito ay awtomatikong papalitan sa oras ng instalasyon. 

 
Paalala: Dapat mong gamitin ang parehong wika sa telepono, sa operating system, 
at Nokia PC Suite, kung maaari. Binibigyang-kakayahan nito ang iyong telepono na 
gumana ng maayos sa lahat ng aplikasyon ng Nokia PC Suite. 
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3. PAG-INSTALL SA MGA DRIVER 

Para ikonekta ang iyong telepono at ang PC para magamit ang mga aplikasyon ng Nokia PC 
Suite kailangan mong mag-install ng mga driver sa pagkakakonek sa iyong PC. Ang mga 
driver sa pagkakakonek ay awtomatikong ini-install kapag nag-install ka ng Nokia PC Suite 
at ikinonekta ang iyong telepono sa PC gamit ang Maging Konektado wizard. 

Kung nais mong gamitin ang iyong telepono bilang modem para kumonekta sa mga serbisyo 
sa network gaya ng Internet kapag walang wired network na magagamit, kailangan mong  
i-install ang mga driver ng modem sa iyong PC. Awtomatikong ini-install ng Nokia PC Suite 
ang mga kinakailangang driver ng modem. 

Ang sumusunod na talahanayan ay nagpapakita ng mga kinakailangang driver ayon sa uri 
ng koneksyon na iyong gagamitin: 

Uri ng koneksyon Mga driver sa pagkakakonek Mga driver ng modem 
USB cable DKU-2, 
DKE-2, CA-53, CA-
70, CA-101 

Serial cable CA-42 

Awtomatikong nai- install. Awtomatikong nai-install. 

Infrared Kailangan mayroon kang Infrared 
port sa iyong PC. Ang mga driver 
ay awtomatikong nai-install kapag 
ikinonekta mo ang iyong telepono 
sa PC sa infrared. 

Ang Nokia infrared modem ay 
awtomatikong nai-install kapag 
ikinonekta mo ang iyong telepono 
sa PC sa infrared. 

Bluetooth wireless 
technology 

Kailangan mayroon kang 
suportadong Bluetooth stack na 
naka-install sa iyong PC. Ang 
mga driver ay awtomatikong nai-
install kapag ikinonekta mo ang 
iyong telepono sa PC sa 
Bluetooth. 

Ang PC Connectivity Bluetooth 
modem ay awtomatikong ini-
install kapag ipinares mo ang 
iyong telepono sa PC sa 
Maging Konektado. 

Kung mayroon kang naka-install 
na Microsoft Bluetooth sa iyong 
PC, isang karaniwang Bluetooth 
modem ang awtomatiko ring ii-
install. 
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4. PAGKONEKTA SA IYONG TELEPONO AT PC 

Kailangan mong ikonekta ang iyong telepono sa PC para gawin ang mga sumusunod: 

• Maglipat ng impormasyon sa pagitan ng mga aplikasyon ng Nokia PC Suite at 
telepono. Halimbawa, para mag-synchronise ng mga tipanan sa kalendaryo o 
maglipat ng mga imahe. 

• Gamitin ang iyong telepono bilang modem para ikonekta ang iyong PC sa mga 
serbisyo sa network gaya ng Internet. 

4.1 Pagpili sa uri ng koneksyon 

Maaari mong ikonekta ang telepono at PC sa USB o serial cable, Infrared (IrDA), o Bluetooth 
wireless technology. Kapag ang instalasyon ng Nokia PC Suite ay natapos, ang Maging 
Konektado wizard ay bubukas at gagabay sa iyo sa pag-configure sa mga uri ng koneksyon 
na nais mong gamitin.  

Ang mga uri ng koneksyon na mapipili mo sa ay depende sa kung anong mga uri ng 
koneksyon ang sinusuportahan ng iyong modelo ng telepono at ng PC. Para tingnan kung 
anong mga uri ng koneksyon ang sinusuportahan ng iyong telepono, tingnan ang 
www.nokia.com/pcsuite/compatibility, o ang gabay sa gumagamit ng iyong telepono. 

Uri ng koneksyon Mga Detalye 
Mga USB cable 
DKU-2, DKE-2, 
CA-53, CA-70, CA-
101 

Ang USB cable ay isang mabilis at maaasahang paraan ng 
paglilipat ng data sa pagitan ng isang telepono at PC. 

Maaari kang magkaroon ng ilang USB cable na koneksyon, o kahit 
magkasabay na serial at USB na koneksyon. 

Kung wala kang natanggap na cable kasama ng iyong telepono, 
maaari kang bumili ng isa mula sa iyong tindero ng Nokia. 

Serial cable CA-42 Ang serial cable ay isang maaasahang paraan ng koneksyon sa 
pagitan ng isang telepono at PC. 

Maaari ka lang makapagtatag ng isang serial cable na koneksyon 
sa isang pagkakataon. 

Kung wala kang natanggap na cable kasama ng iyong telepono, 
maaari kang bumili ng isa mula sa iyong tindero ng Nokia. 

Infrared Ang infrared ay wireless na nagkokonekta ng iyong telepono sa PC 
sa maikling range. Ang mainam na distansiya sa pagitan ng 
telepono at ng PC ay isang metro (mga tatlong piye) sagad na. 

Bluetooth Ang Bluetooth wireless technology ay wireless na nagkokonekta ng 
iyong telepono sa PC sa maikling range. Ang telepono at ang PC ay 
dapat nasa loob ng 10 metro (mga 30 piye) na radius ng bawat isa. 
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Paalala: Ang ilang modelo ng telepono ay may opsyonal na setting ng seguridad na 
tinatawag na autolock period, na nagtatakda ng time-out period matapos ay mala-lock 
ang aparato kung ito ay nasa standby mode. Bago ka makapagtatag ng koneksyon sa 
pagitan ng iyong telepono at Nokia PC Suite kailangan mong i-unlock ang iyong telepono. 

4.2 Pagkonekta ng iyong telepono sa cable 

1. Sa Maging Konektado, piliin ang Cable na koneksyon bilang uri ng koneksyon. 

2. Ikonekta ang cable sa PC kapag hiningi sa iyong gawin ng Maging Konektado, 
at ikonekta ang kabilang dulo ng cable sa telepono. 

3. Sa unang paggamit mo ng cable na koneksyon kailangan mong maghintay hanggang 
matapos ang Maging Konektado sa pag-install ng mga kinakailangang driver. 

 
Note: Bagaman ang CA-42 cable ay isang serial cable, ikonekta ito sa USB connector 
ng iyong computer sapagkat kinikilala ito ng Windows bilang isang USB cable. Ang COM 
port ay karaniwang awtomatikong pinipili. Kung hindi, maaari mong manwal na i-
configure ito sa Nokia Connection Manager. Para ma-access ang Nokia Connection 
Manager, i-click ang Mga setting > Pamahalaan ang mga koneksiyon sa pangunahing 
window ng Nokia PC Suite. Piliin ang Serial cable na uri ng koneksiyon at i-click ang I-
configure… para itakda ang COM port. Kailangan mong gawin ang pag-configure na ito 
ng isang beses lamang, bago mo magamit ang koneksiyon sa unang pagkakataon. 

 
Paalala: Kapag ikinonekta mo ang iyong telepono sa PC sa USB cable, tiyakin na napili 
mo ang default o PC Suite mode sa iyong telepono kung nais mong gamitin ang Nokia 
PC Suite sa iyong telepono. Tingnan ang gabay sa gumagamit ng iyong telepono para 
sa detalyadong impormasyon sa mga nakahandang USB mode. 

 
Paalala: Laging tiyakin na ikaw ay gumagamit ng mga orihinal na Nokia cable sa Nokia 
PC Suite upang matiyak ang secure na operasyon ng mga aplikasyon ng PC Suite. 
Tiyakin ang tatak sa iyong cable. 

4.3 Pagkonekta ng iyong telepono sa infrared 

1. Iaktibo ang IR port ng iyong telepono. Para sa mga tagubilin, tingnan ang gabay sa 
gumagamit ng iyong telepono. 

2. Kung ikaw ay gumagamit ng teleponong Symbian, tiyaking napili mo ang infrared na 
uri ng koneksyon sa iyong telepono. Para sa mga tagubilin, tingnan ang gabay sa 
gumagamit ng iyong telepono. 

3. Ipuwesto ang telepono at ang PC upang ang mga IR port ng dalawang aparato ay 
nakaturo sa bawat isa. 

4. Ang koneksyon ay awtomatikong gagawin. 

4.4 Pagkonekta ng iyong telepono sa Bluetooth 

1. Gawing nakikita ang iyong telepono sa ibang Bluetooth na aparato at iaktibo ang 
Bluetooth na koneksyon ng iyong telepono. Para sa mga tagubilin tingnan ang gabay 
sa gumagamit ng iyong telepono. 

 
11/28  



2. Kapag iyong iniaktibo ang Bluetooth sa unang pagkakataon hihingin sa iyo na 
pangalanan ang iyong telepono. Ang pangalan ay gagamitin tuwing ipinapares mo ang 
iyong telepono at PC. 

3. Tiyakin na ang Bluetooth stack sa iyong PC ay nakabukas. 

4. Kung ikaw ay gumagamit ng Bluetooth adapter, tiyaking nakakabit ito sa PC. 

5. Piliin ang Mag-click dito para magkonekta ng telepono na text sa itaas ng imahe ng 
telepono sa pangunahing window ng Nokia PC Suite para mabuksan ang Maging 
Konektado, at sundin ang mga tagubilin sa wizard para ipares ang iyong telepono sa 
PC. 

Kung kailangan mong alamin kung anong mga Bluetooth stack ang na-install sa iyong PC, 
i-click ang Tulong > Tungkol sa Nokia PC Suite... > System info… sa pangunahing 
window ng Nokia PC Suite. Kung ang Bluetooth stack na natagpuan sa iyong PC ay di 
suportado ng Nokia PC Suite, ang impormasyong ito ay nasa info sa sistema rin. 

4.4.1 Pagpapares ng mga aparato para sa Bluetooth na koneksyon 

Para magamit ang Bluetooth bilang uri ng koneksyon, kailangan mong ipagpares ang iyong 
telepono at PC. Ang pagpapares ay nangangahulugang kino-code mo ang dalawang Bluetooth 
na aparato para makapagkomunikasyon upang makapagpalitan ng data ang mga ito. Minsan 
mo lang ipapares ang mga aparato, bago mo magamit ang koneksyon sa unang pagkakataon.  

Sundin ang mga tagubilin pagpapares sa Maging Konektado at tandaan: 

• Kung ginamit mo ang passcode na ginawa ng Maging Konektado, ipasok ang 
passcode sa telepono kapag hiningi. Isa pang paraan, maaari kang gumawa ng sarili 
mong passcode (1-16 na karakter, numerikal) at ipasok muna ang parehong passcode 
sa PC at pagkatapos ay sa telepono kapag hiningi. Ang passcode na ito ay isang 
beses lang gagamitin at hindi mo ito kailangang kabisaduhin. 

• Kailangan mong pahintulutan ang koneksyon sa pagitan ng iyong Nokia phone at ng 
iyong PC. Piliin ang Oo kapag nakita mo ang hiling na koneksyon sa display ng telepono. 

• Maaari mong itakda ang iyong PC bilang awtorisado, na nangangahulugan na ang 
mga indibidwal na koneksyon sa pagitan ng iyong telepono at ng iyong PC ay hindi 
kailangan ng hiwalay na awtorisasyon. Sa iyong telepono, hanapin ang view ng 
Magkapares na aparato, piliin ang iyong PC, at i-edit ang PC para pahintulutan o 
pagkatiwalaan, depende sa katawagan na ginagamit sa iyong telepono. 

4.5 Mga konektadong telepono 

Matapos mong maikonekta ang iyong telepono sa PC, makikita mo ang pangalan at uri ng 
koneksiyon ng telepono sa pane sa pagpili ng telepono at indikasyon ng progreso sa 
pangunahing window ng Nokia PC Suite.  

Kung marami kang konektadong telepono sa PC, piliin ang telepono na nais mong gamitin 
mula sa drop-down na lista ng pane. 
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Kung nais mong magkonekta ng bagong telepono na dagdag pa sa mga kasalukuyang 
konektadong telepono, o palitan ang uri ng koneksiyon ng isang konektadong telepono, 
maaari mong gawin ito sa Maging Konektado wizard. Para simulan ang wizard, i-click ang 
Mga setting > Magdagdag ng iba pang telepono sa pangunahing window ng Nokia PC 
Suite. 
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5. PAGGAMIT NG NOKIA PC SUITE 

Ang sumusunod na seksyon ay nagbibigay sa iyo ng mga tagubilin para masimulang gamitin 
ang mga aplikasyon ng Nokia PC Suite. Para sa mga karagdagang mas detalyadong 
tagubilin, tingnan ang Nokia PC Suite tulong (Tulong > Mga tulong na paksa) at Tutorial 
(Web > Nokia PC Suite tutorial). 

 
Paalala: Ang Nokia Multimedia Player, Image Store, at Nokia Music Manager ay di 
kasama sa Nokia PC Suite Starter Edition. 

 
Paalala: Halimbawa, di lahat ng modelo ng telepono, halimbawa, ay sumusuporta sa 
pagpapadala ng mga mensaheng multimedia. Para tingnan kung anong mga aplikasyon 
ng Nokia PC Suite ang magagamit mo sa iyong telepono, tingnan ang 
www.nokia.com/pcsuite/compatibility. 

Para buksan ang Nokia PC Suite, gawin ang isa sa mga sumusunod: 
a. Sa Windows taskbar, i-click ang icon ng Nokia PC Suite. 
b. Sa desktop ng iyong computer, idobleng-click ang icon ng Nokia PC Suite. 
c. Mula sa Windows Start menu, i-click ang Programs > Nokia PC Suite. 

 
Tip: Ang Nokia PC Suite ay laging bumubukas kapag binuksan mo ang iyong PC. Kung 
nais mong pigilan ang awtomatikong startup, pumunta sa File menu sa pangunahing 
window ng PC Suite at i-deselect ang opsyon na Buksan sa startup  
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5.1 Pangunahing window ng Nokia PC Suite 

 

Larawan 1. Pangunahing window ng Nokia PC Suite (larawan sa Ingles) 

Ang pangunahing window ng Nokia PC Suite ay pinaghati-hati sa mga bahaging 
nakalarawan sa ibaba: 

Bahagi Deskripsyon 

Pane ng aplikasyon • Ipinapakita ang mga karaniwang aplikasyon na kasama sa Nokia PC 
Suite at mga posibleng karagdagang aplikasyon na maaaring nai-
download mo at nai-install mula sa mga pahina sa web ng Nokia PC 
Suite. 

• Para buksan ang isang aplikasyon, i-click ang icon nito o piliin ito 
mula sa menu na File. 
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Status pane • Nagpapakita ng abiso kung may mga bagong add-on na aplikasyon, 
update sa mga naka-install na add-on na aplikasyon o mga update 
sa Nokia PC Suite na magagamit para sa iyong telepono. 

Pane sa pagpili ng 
telepono at indikasyon 
ng progreso 

• Nagpapakita ng mga kasalukuyang konektadong telepono sa PC. 

• Kung wala kang teleponong konektado sa PC, gamitin ang Maging 
Konektado wizard para gawin ang koneksiyon. Para ma-access ang 
Maging Konektado, piliin ang Mag-click dito para magkonekta ng 
telepono na text sa itaas ng imahe ng telepono. 

• Kung marami kang konektadong telepono sa PC, piliin ang telepono 
na nais mong gamitin mula sa drop-down na lista ng pane. 

• Para maglipat ng musika, mga imahe, at mga file na video at mga 
aplikasyon sa iyong telepono, i-drag-and-drop ang mga file sa imahe 
ng telepono. 

Pane ng mensahe • Nagpapakita ng mga pinakahuling text na mensahe mula sa iyong 
konektadong telepono. 

• Para i-update ang mga mensahe na ipinapakita sa pane ng 
mensahe, pindutin ang F5. 

• I-dobleng click ang isang mensahe para buksan ito sa Nokia Text 
Message Editor kung saan masasagot mo ang mensahe o 
maipapasa ito. 

• I-click ang handle sa itaas na gilid ng pane ng mensahe para i-
maximize o i-minimize ang pane. 

5.2 Pag-back up sa mga nilalaman ng telepono a isang PC 

Nokia Content Copier ay nagbibigay kakayahan sa iyo na i-back ang mga nilalaman ng iyong 
telepono sa PC. Maaari mong i-back ang buong nilalaman, o piliin kung ano ang nais mong i-
back up. Dapat na regular mong i-back up ang mga laman ng iyong telepono para maiwasan 
ang pagkawala ng mahalagang data. 

Maaari mong ibalik ang mga nilalaman ng telepono sa parehong modelo ng telepono kung 
saan orihinal na ginawa ang backup, o i-import ang mga nilalaman sa isa pang modelo ng 
Nokia phone. Kung nagbabalik ka ng backup file sa parehong modelo ng telepono na orihinal 
na na-back up, ang kasalukuyang data sa iyong telepono ay pinapalitan ng data mula sa 
backup file. 

 
Paalala: Huwag gamitin o idiskonekta ang iyong telepono habang bina-back up o 
ibinabalik ng Nokia Content Copier ang mga nilalaman ng telepono. 

 
Paalala: Ang mga proteksyon sa karapatang-ari ay maaaring pumigil sa ilang imahe, 
tono ng ring, at iba pang nilalaman para makopya, mabago, mailipat, o maipasa. 

 
Paalala: Ang ilang nilalaman ay maaari lang ibalik sa parehong modelo ng telepono 
kung saan una itong nai-back up depende sa uri ng data na sinusuportahan ng 
puntiryang telepono. 
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Para i-back up ang mga nilalaman ng iyong telepono 
1. Ikonekta ang iyong telepono sa PC. Tandaan na ang USB cable ang pinakamabilis na 

uri ng koneksyon para sa paglilipat ng malalaking file sa pagitan ng iyong telepono at 
PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang I-backup  para buksan 
ang Nokia Content Copier. 

3. I-click ang I-back up.  

4. Mula sa lista ng mga nakahandang uri ng nilalaman, piliin kung ano ang nais mong i-
back up, at i-click ang Susunod. 

5. Magtakda ng pangalan at lokasyon na paglalagyan para sa backup file, at i-click ang 
Susunod. Matapos mai-back up ang mga nilalaman ng telepono, i-click ang Tingnan 
ang ulat kung nais mong makita ang detalyadong impormasyon tungkol sa operasyon 
sa pag-backup. 

Para ibalik o i-import ang isang backup file 
1. Ikonekta ang iyong telepono sa PC. Tandaan na ang USB cable ang pinakamabilis na 

uri ng koneksyon para sa paglilipat ng malalaking file sa pagitan ng iyong telepono at 
PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang I-backup  para buksan 
ang Nokia Content Copier. 

3. I-click ang Ibalik. 

4. Pumili ng backup file na ibabalik o ii-import, at i-click ang Susunod. 

5. Mula sa lista ng mga nakahandang uri ng nilalaman, piliin kung ano ang nais mong 
ibalik o i-import, at i-click ang Susunod. Matapos maibalik o ma-import ang mga 
nilalaman ng telepono, i-click ang Tingnan ang ulat kung nais mong makita ang 
detalyadong impormasyon tungkol sa operasyon sa pagbabalik o pag-import. 

5.3 Pag-synchronise ng data sa pagitan ng iyong telepono at PC  

Ang Nokia PC Sync ay nagbibigay kakayahan sa iyo na i-synchronise ang mga contact, mga 
bagay sa kalendaryo/gagawin, mga tala, at mga e-mail sa pagitan ng isang Nokia mobile 
phone at ng iyong PC Personal Information Manager (PIM). Maaari mo rin i-synchronise ang 
mga tanda at mga RSS feed sa pagitan ng isang Nokia mobile phone at ng suportadong web 
browser, o mga file at folder sa pagitan ng isang Nokia mobile phone at ng PC. Ang pag-
synchronise ay nangangahulugan na ang kapwa impormasyon sa iyong telepono at PC ay 
magkapareho Tnadaan na hindi lahat ng model ng telepono ay sumusuporta ng, halimbawa, 
pag-synchronise ng mga e-mail o mga tanda at mga RSS feed. 

Maaari mong i-synchronise ang isang tugmang Nokia phone sa mga sumusunod na PC PIM 
na aplikasyon: 

• Microsoft Outlook 2000, 2002, 2003 at 2007 

• Microsoft Outlook Express (Windows Address Book) 
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• Microsoft Windows Vista Calendar at Mga Contact 

• Lotus Notes 5.x, 6.x at 7.0 

• Lotus Organizer 5.x at 6.x 

Para gawin ang unang gawain sa pag-synchronise 
1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang I-synchronise , para 
buksan ang PC Sync. 

3. Kapag binuksan mo ang Nokia PC Sync sa unang pagkakataon, ang Mga setting 
wizard ay awtomatikong bubukas. Maaari mong laktawan ang wizard at simulan ang 
pag-synchronise sa mga default na setting, o sundin ang mga tagubilin sa screen para 
tapusin ang proseso ng wizard. Nirerekomenda na iyong sundin ang wizard para 
maitama mo ang mga personal na setting sa pag-synchronise. Sundin ang mga 
tagubilin sa screen para itakda, halimbawa: 
• PIM na aplikasyon kung saan nais mong i-synchronise ang telepono. 
• Impormasyon na nais mong i-synchronise. 
• Mga setting para sa mga bagay na iyong napili para sa pag-snchronise. 

4. Sa Tapos na pahina ng wizard, i-click ang Advance kung nais mong gumawa ng mga 
setting para sa awtomatikong pag-synchronise at pagresolba sa conflict. 

Para sa karagdagang impormasyon sa mga setting, tingnan ang Nokia PC Suite tulong. 

Para gumawa ng bagong gawain sa pag-synchronise 
1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang I-synchronise , para 
buksan ang PC Sync. 

3. I-click ang Mga setting. 

4. I-click ang Gumawa ng mga bagong setting. 

5. Sa mga pahina ng Mga settings wizard, piliin, halimbawa, ang PC PIM na aplikasyon 
na nasi mong gamitin kapag nagsi-synchronise, anong impormasyon ang nais mong 
i-synchronise, at ang range ng pag-synchronise. 

6. Sa huling pahina ng wizard, i-click ang Advanced kung nais mong gumawa ng mga 
setting para sa awtomatikong pag-synchronise at pagresolba sa conflict. Batay sa 
kung ano ang nais mong i-synchronise, ang mga tab sa window ng Mga setting ay 
maaaring aktibo o di aktibo. Punan ang mga aktibong tab. 

7. I-click ang OK para tapusin ang paggawa ng bagong gawain ng pag-synchronise. 

Para sa karagdagang impormasyon tungkol sa mga setting, tingnan ang Nokia PC Suite 
tulong. 
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Ang icon ng Nokia PC Sync ay ipinapakita sa taskbar kapag ang Nokia PC Sync ay aktibo: 

•  nagpapakita na ang telepono ay konektado. Maaari mong i-click ang icon para 
buksan ang PC Sync, o ikanang-click ang icon para i-access ang mga menu 
command ng Nokia PC Sync,  

•  nagpapakita na ang telepono ay di konektado. 

 
Paalala: Bilang default ang Nokia PC Sync ay di naitakda para awtomatikong magsimula 
kapag binuksan mo ang iyong PC. Para gawin na awtomatikong magsimula ang PC 
Sync kapag binuksan mo ang iyong PC: 

1. I-click ang I-synchronize sa pangunahing window ng Nokia PC Suite. 
2. Ikanang-click ang icon ng Nokia PC Sync sa Windows taskbar. 
3. Piliin ang Paganahin Sa Startup. 

5.4 Pagkonekta sa Internet gamit ang iyong telepono 

Sa aplikasyon na One Touch Access ng Nokia PC Suite magagamit mo ang iyong telepono 
bilang modem para gumawa ng koneksyon sa network sa Internet. Ang koneksyon ay 
maitatatag sa cable, infrared, o Bluetooth wireless technology. 

Para magamit ang iyong telepono bilang modem, kailangang mayroon ka ng mga 
sumusunod: 

• Isang telepono at subskripsyon na sumusuporta ng packet data. 

• Wastong software na naka-install sa iyong PC para sa mga data na komunikasyon. 

• Subskripsyon sa mga wastong serbisyo sa network mula sa iyong sariling 
tagapaglaan ng serbisyo o tagapaglaan ng serbisyo sa Internet. 

• Mga wastong driver ng modem na naka-install sa iyong PC. Awtomatikong ini-install 
ng Nokia PC Suite ang mga ito. 

 
Paalala: Dinedetekta ng One Touch Access ang konektadong telepono at awtomatikong 
ginagamit ito bilang modem. Gayunman, kung ang iyong telepono ay konektado sa PC 
sa Bluetooth, awtomatikong kinikilala lang ng One Touch Access ang telepono kung 
walang ibang konektadong modem na magagamit at gumamit ka ng Bluetooth modem 
sa naunang beses na ginamit mo ang One Touch Access. 

 
Paalala: Kung ang iyong telepono ay di sumusuporta ng packet data maaari mong i-access 
ang Internet sa paggawa ng dial-up na koneksyon. Tingnan ang mga tagubilin sa 
paggamit ng iyong telepono bilang modem sa Nokia PC Suite tulong. 

Para kumonekta sa Internet 
1. Ikonekta ang iyong telepono sa PC. 

2. Kung ikaw ay gumagamit ng CA-42 serial cable o infrared para sa koneksyon sa 
pagitan ng Nokia PC Suite at ng iyong telepono, kailangang alisin ang pagpili sa mga 
uri ng koneksyon upang magamit mo ang uri ng koneksyon para sa modem. 
Awtomatikong inaalis ng One Touch Access ang pagpili sa mga uri ng koneksyon 
kapag gumagawa ng koneksyon, at muling pinipili ang mga ito kapag diniskonekta ang 
modem. 
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3. Sa pangunahing window ng Nokia PC Suite, i-click ang Kumonekta sa Internet  
para buksan ang One Touch Access. Awtomatiko itong kukonekta sa Internet matapos 
ang 10 segundo.  
O 
Buksan ang One Touch Access at i-click ang Mga setting para piliin ang modem na 
nais mong gamitin at ang operator ng iyong network mula sa lista ng mga operator, at 
i-click ang Ikonekta para maitatag ang koneksyon sa Internet. 

4. Kapag di mo na kailangan ang koneksyon, i-click ang Idiskonekta para isara ang 
koneksyon sa Internet. 

5.5 Pag-install ng mga aplikasyon sa iyong telepono mula sa PC 

Sa Nokia Application Installer maaari mong i-install ang mga aplikasyong Symbian at Java™ 
tulad ng mga kalendaryo o mga laro mula sa isang PC papunta sa iyong telepono. Ang mga 
uri ng file na maaari mong i-install sa Nokia Application Installer ay .SIS, .SISX, .JAR, at .N-
GAGE. Maaari kang mag-download ng mga aplikasyon sa iyong PC, halimbawa, mula sa 
mga pahina sa Web ng Nokia o sa mga pahina ng ibang tagapaglaan ng serbisyo. Maaari ka 
ring mag-install ng mga aplikasyon na iyong ginawa mismo. 

Para mag-install ng aplikasyon sa iyong telepono 
1. I-download ang mga .SIS, .SISX, .JAR, o .N-GAGE file para sa aplikasyon na nais 

mong i-install. 

2. Ikonekta ang iyong telepono sa PC. 

3. Sa Windows Explorer, magdobleng-click sa .SIS, .SISX, .JAR, o .N-GAGE file na 
nais mong i-install sa iyong telepono. Ini-install ng Nokia Application Installer ang 
aplikasyon sa iyong telepono. 

Tandaan na kung mayroon kang telepono na may Symbian operating system, kailangan 
mong tapusin ang pag-install sa parte ng telepono. 

Kung nais mong, halimbawa, piliin kung ii-install ang aplikasyon sa memorya ng telepono, 
mass memory o kard ng memorya, gamitin ang Nokia Application Installer para i-install ang 
aplikasyon. 

Para buksan ang Nokia Application Installer, i-click ang I-install ang mga aplikasyon  
sa pangunahing window ng Nokia PC Suite. Para sa mga tagubilin sa paggamit, tingnan ang 
Nokia Application Installer tulong. 

Para sa karagdagang impormasyon tungkol sa kung anong uri ng mga aplikasyon ang 
maaaring i-install sa iyong telepono, tingnan ang gabay sa gumagamit ng iyong telepono. 

 
Paalala: Tandaan na ang Nokia ay di nagbibigay garantiya sa mga aplikasyong mula sa 
mga di-Nokia na site. Kung pinili mong mag-download ng mga aplikasyon mula sa mga 
ito, dapat mong gawin ang parehong pag-iingat, para sa seguridad o nilalaman, tulad ng 
gagawin mo sa anumang site. 
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5.6 Pamamahala sa mga nilalaman ng telepono sa PC 

Kapag ikinonekta mo ang iyong telepono sa PC gamit ang Nokia PC Suite, ang PC Suite ay 
gumagawa ng folder ng telepono na matitingnan sa Windows Explorer, sa ilalim ng Nokia 
Phone Browser. Ipinapakita ng Nokia Phone Browser ang mga folder at subfolder ng 
telepono para sa bawat teleponong konektado sa PC. Dagdag pa sa memorya ng telepono, 
ang isang kard ng memorya at mass memory ay ipinapakita bilang mga subfolder ng 
telepono kung nakahanda sila sa telepono. Tandaan na hindi lahat ng modelo ng telepono 
ay sumusporta ng mga kard ng memorya o mass memory.  

Sa Nokia Phone Browser maaari mong tingnan ang mga file at folder at ilipat ang mga ito sa 
pagitan ng iyong telepono at PC sa Windows Explorer sa parehong paraan na gagawin mo 
sa anumang file o folder sa iyong PC. 

 

Larawan 2. Nokia Phone Browser sa Windows Explorer (larawan sa Ingles) 

Para kumopya ng mga file/mga folder sa pagitan ng telepono at ng PC 
1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang Manager ng file  para 
buksan ang Nokia Phone Browser,  
O 
sa Windows Explorer, pumunta sa My Computer > Nokia Phone Browser > Nokia 
xxxx kung saan ang xxxx ay ang numero ng modelo ng telepono. Kung binigyan mo 
ang iyong telepono ng isang kilalang pangalan gaya ng "Telepono ko" ang folder ay 
magkakaroon ng gayong pangalan. 

3. I-drag and drop ang mga file o folder sa pagitan ngiyong telepono at PC, o gamitin ang 
ikopya-idikit. 

 
Tip: Para i-refresh ang mga nilalaman ng telepono, piliin ang View > I-refresh o i-click 
ang F5. 
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Paalala: Ang pagkopya ng mga file mula sa PC papunta sa isang telepono ay maaaring 
magtagal, depende sa laki ng mga file at ang uri ng koneksyon na iyong ginagamit. 
Huwag idiskonekta ang telepono bago maikopya ang mga file. Ang USB cable (DKU-2, 
DKE-2, CA-53, CA-70 o CA-101) ay ang pinakamabilis na uri ng koneksyon para sa 
paglilipat ng malalaking file gaya ng mga file na musika sa pagitan ng iyong telepono at 
PC. 

5.7 Pagdaragdag ng mga contact sa iyong telepono mula sa PC 

Sa Nokia Contacts Editor maaari mong buksan at i-edit, i-save at i-print ang mga contact na 
iyong nai-save sa iyong telepono. Maaari mo rin tingnan ang mga contact sa iyong telepono 
sa view ng Mga contact ng Nokia Phone Browser. 

Para gumawa ng bagong contact sa iyong telepono. 
1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang Mga contact  . Ang Nokia 
Phone Browser ay bubukas na nakikita ang folder ng Mga contact ng iyong telepono. 

3. Sa Nokia Phone Browser, piliin ang folder ng Mga Contact at i-click ang Contact > 
Bagong Contact. 

4. Magdagdag ng mga detalye sa contact. 

5. I-click ang I-save. 

5.8 Pagpapadala ng mga tekstong mensahe mula sa PC 

Sa Nokia Text Message Editor maaari kang tumanggap at magpadala ng mga text na 
mensahe mula sa iyong PC, gumwa ng mga folder para sa pagtatabi ng mga text na 
mensahe, at i-export ang iyong mga text na mensahe mula sa iyong telepono papunta sa 
iyong PC. 

Para magpadala ng tekstong mensahe  
1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang Mga mensahe . Ang 
Nokia Phone Browser ay bubukas na nakikita ang folder ng Mga mensahe ng iyong 
telepono. 

3. Sa Nokia Phone Browser i-click ang Mensahe > Bagong Tekstong Mensahe. 

4. Isulat ang numero ng telepono sa Para kay… field, o i-click ang Para kay… para piliin 
ang mga tatanggap ng mensahe. Ang mga tatanggap ay ipinapakita sa folder ng Mga 
Contact ng Nokia Phone Browser. 

5. Isulat ang mensahe at i-click ang File > Ipadala. 
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5.9 Pagtingin ng mga file na multimedia sa PC 

Sa Nokia Multimedia Player maaari kang mag-play ng mga file na multimedia files na 
nakatabi sa PC o direkta mula sa iyong telepono kapag konektado ito sa PC. Maaari kang 
gumawa ng mga playlist ng, halimbawa, mga retrato o video clip na nakunan mo sa iyong 
kamera, at panoorin sila ng sunod-sunod. Maaari ka rin mag-save ng mga file na video at 
audio sa isang pormat na nagbibigay kakayahan sa iyo na magamit ang mga ito sa isang 
teleponong mobile o ilakip ang mga ito sa isang MMS na mensahe. 

Para gamitin ang mga playlist upang tingnan ang iyong mga paboritong file 

1. Sa pangunahing window ng Nokia PC Suite, i-click ang Tingnan ang multimedia  
para buksan ang Nokia Multimedia Player. 

2. I-click ang View > Playlist para buksan ang view ng playlist. Ang view ay bubukas na 
may bakanteng lista.  

3. I-click ang Idagdag ang mga file sa playlist para idagdag ang mga file sa playlist, 
o i-drag ang mga file sa playlist mula sa Windows Explorer. 

4. I-click ang I-save ang playlist sa file o i-click ang File > I-save ang Playlist. 
Pangalanan ang playlist at i-click ang I-save. Ang file ay isi-save na may extension 
na .npl. 

5. I-click ang View > Mga opsyon para itakda ang mga opsyon sa pagtingin. Maaari 
mong, halimbawa, itakda ang playback para awtomatikong magsimula, at itakda ang 
oras ng antala sa pagitan ng pagpapakita ng mga file sa slideshow. 

6. I-click ang File > Buksan at piliin ang playlist na titingnan. Kung wala kang 
makitang .npl o .m3u file sa dialog ng Bukas, para sa Mga file ng uri, piliin ang Mga 
playlist o Lahat ng suportadong pormat. 

5.10 Pagtatabi ng mga imahe mula sa iyong telepono papunta sa PC 

Sa Image Store maaari mong itabi ang mga retrato at mga video clip na iyong kinunan sa 
kamera ng iyong telepono. 

1. Ikonekta ang iyong telepono sa PC. 

2. Sa pangunahing window ng Nokia PC Suite, i-click ang Itabi ang mga imahe  
para buksan ang Image Store. 

3. Kung di mo pa nagamit dati ang Image Store, ang Mga setting wizard ay 
awtomatikong bubukas kapag nakakonekta ang iyong telepono sa PC at binuksan mo 
ang Image Store. Bago ka makapagtabi ng mga imahe, kailangan mong itakda ang 
mga uri ng file na itatabi (mga imahe o video), ang puntiryang folder na paglalagyan, 
at kung ang ang ginagawa ng Image Store kapag naitabi ang mga file. 

4. I-click ang Itabi Ngayon. Ang mga file ay itatabi sa folder na iyong itinakda. 
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Kung nais mong baguhin ang mga setting, i-click ang Mga setting sa pangunahing window 
ng Image Store. Maaari mong itakda, halimbawa, kung nais mong awtomatikong itabi ang 
mga bagong imahe at video sa iyong PC tuwing ikinokonekta mo ang iyong telepono sa PC, 
at kung anong aplikasyon ang iyong gagamitin para tingnan ang mga imahe at video clip. 
Para sa karagdagang impormasyon tungkol sa mga setting, tingnan ang Nokia PC Suite 
tulong. 

5.11 Paglilipat ng musika mula sa CD papunta sa iyong telepono 

Sa Nokia Music Manager, maaari kang mag-rip ng mga audio CD na may impormasyon sa 
track at album, gumawa at magsaayos ng mga digital na file ng musika at mga playlist sa 
telepono at PC, maglipat ng mga file na musika at mga playlist sa pagitan ng telepono at PC, 
at playback na musika mula sa CD o PC. 

Sa Nokia Music Manager maaari kang mag-play, halimbawa, ng mga AAC, MP3 at M4A na 
track ng musika. 

 
Paalala: Sa USB cable (DKU-2, DKE-2, CA-53, CA-70 o CA-101) na koneksyon, maaari 
kang maglipat ng malalaking file gaya ng mga file ng musika sa pagitan ng iyong 
telepono at ng PC na mas mabilis kaysa sa ibang uri ng koneksyon. 

 
Paalala: Ipapaalam sa iyo ng bar ng titulo ng Nokia Music Manager kung ang iyong 
telepono ay di suportado. 

 
Paalala: Ang mga proteksyon sa karapatang-ari ay maaaring pumigil sa ilang musika na 
mai-rip at mailipat. 

Para maglipat ng musika mula sa CD papunta sa iyong telepono 
1. Ikonekta ang iyong telepono sa PC. 

2. Ipasok ang isang CD ng musika sa CD drive o DVD drive ng iyong PC. 

3. Sa pangunahing window ng Nokia PC Suite, i-click ang Ilipat ang Musika   para 
buksan ang Nokia Music Manager. 

4. Buksan ang view ng CD para tingnan ang mga track sa CD. 

5. Kung nais mong baguhin ang pangalan ng mga file, i-highlight ang mga gustong track, 
i-kanang click anuman sa mga track, at piliin ang I-edit mula sa pop-up menu. 

6. Piliin ang data na nais mong ilipat sa iyong telepono. 

7. I-click ang File > Ikopya sa telepono. Ang mga file ay iko-convert sa .aac o .m4a na 
pormat ng file at ililipat sa iyong telepono. 

 
Tip: Ang mga track ay sini-save bilang default sa kard ng memorya kung mayroon kang 
isa na nakapasok sa iyong telepono. Maaari mong palitan ang puntiryang folder sa 
telepono sa Mga opsyon > Mga setting, tab ng telepono.  

Maaari ka ring maghanap ng mga track ng musika mula sa iyong PC para ilipat sa iyong 
telepono. Para gawin ito, i-click ang I-scan ang PC para sa mga file na musika, at ikopya 
ang mga napiling track sa iyong telepono. 

Kung ang iyong telepono ay sumusuporta sa pag-play ng mga track sa M4A na pormat, 
maaari mong gamitin ang eAAC+ na encoding para sa pag-rip ng musika mula sa CD. Para 
gawin ito, i-click ang Mga opsyon > Mga setting, at sa tab ng pag-convert piliin ang M4A 
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para sa Pormat sa pag-convert. Sa pag-convert na ito, ang ratio ng kompresyon ay mas 
mataas kaysa sa AAC na encoding at maaari kang mag-save ng mas maraming musika sa 
memorya ng iyong telepono o sa kard ng memorya. Sumangguni sa gabay sa gumagamit ng 
iyong telepono para sa karagdagang impormasyon tungkol sa mga suportadong pormat. 
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6. MGA KATAWAGAN AT MGA DAGLAT 

Katawagan Paliwanag 
Bluetooth stack Isang set ng software na kailangan upang paganahin ang Bluetooth sa PC. 

Bluetooth 
wireless 
technology 

Isang teknolohiya na nagbibigay ng mga malapitang link sa radyo na 
nagbibigay-kakayahan sa mga mobile na computer, mga teleponong mobile, 
mga digital na kamera, at iba pang nabibitbit na aparato para makapag-
komunikasyon sa bawat isa na walang mga cable. Isang Nokia mobile na 
aparato na may suporta sa Bluetooth wireless technology na nagbibigay-
kakayahan sa gumagamit para wireless na kumonekta sa isa pang tugmang 
Bluetooth na aparato na nasa malapit. 

COM port Isang input/output port kung saan ang data ay seryal na ipinapadala at 
tinatanggap. Ang serial port ay isang socket sa PC. Ito ay ginagamit para 
ikonekta ang mga seryal na aparato (karaniwan ay mga printer, modem, o 
mouse) sa computer at makipag-komunikasyon sa mga aparatong ito. Ang 
mga serial port ay may mga nakatalagang pangalan gaya ng COM1 at COM2.

Driver Isang programa sa computer na nagbibigay-kakayahan sa ibang programa 
para makipag-komunikasyon sa isang hardware na aparato. 

packet data Isang paraan ng paglilipat ng data (halimbawa, GPRS, 3G) na naglilipat at 
tumatanggap ng data sa packet kaysa gumamit ng tuloy-tuloy na channel. 
Binabayaran lang ng mga gumagamit ang dami ng data na ipinadala at 
natanggap. 

Pag-rip Proseso ng pagkopya ng data mula sa isang anyo ng media papunta sa isang 
hard disk. Halimbawa, musika mula sa isang CD ng audio papunta sa PC. 

Patch Ang isang patch ay isang piraso ng software na ginawa upang mapabuti ang 
paggamit o performance ng isang program sa computer, o para ayusin ang 
mga problem sa isang program sa computer. 

PIM Personal Information Manager gaya ng Microsoft Outlook o Lotus Notes. Sa 
PIM na aplikasyon maaari mong pamahalaan ang impormasyong personal at 
business gaya ng impormasyon ng phone book, kalendaryo, at tala. 

RSS feed Ang isang RSS feed ay nagbibigay sa iyo ng paraan na masubaybayan ang 
isang madalas i-update na website (halimbawa, isang blog o site ng balita). 
Matapos kang mag-subscribe sa isang feed sa Internet, aabisuhan ka sa mga 
update sa nilalaman ng site. Kung kaya, hindi mo na kailangang mag-browse 
sa isang partikular na site para alamain kung may mga pagbabago o bagong 
artikulo. 

SP Service Pack. Isang software patch na ginagamit sa naka-install na 
aplikasyon. 

Symbian Isang smartphone operating system na ibinigay ng kumpanyang naglilisensiya 
ng software na pag-aari ng malalaking kumpanya ng wireless na industriya. 
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7. MGA TALANG PANGKALIGTASAN 

 
Mga mahalagang talang pangkaligtasan 
Ang lahat ng tagubiling pangkaligtasan sa gabay sa gumagamit ng iyong telepono 
at computer ay nauukol rin kapag ang produktong ito ay ginamit sa telepono. 

Tandaang gumawa ng mga backup na kopya ng lahat ng mahahalagang data 
bilang proteksyon sa posibleng pagkawala o pagbabago. 

Mag-install at gumamit lang ng mga aplikasyon at iba pang software mula sa mga 
pinagkukunan na nagbibigay ng sapat na proteksyon laban sa mapaminsalang 
software. 
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